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This manual is part of a set of Color Controller E-820™ documentation that includes 

the following manuals for users and system administrators:

• The Quick Start Guide summarizes the steps for configuring the E-820 and printing. 

It also describes how to access the online documentation. 

• The User Software Installation Guide describes how to install software from the 

User Software CD to enable users to print to the E-820, and also describes setting 

up printing connections to the E-820.

• The Configuration Guide explains basic configuration and administration of the 

E-820 for the supported platforms and network environments. It also includes 

guidelines for setting up UNIX, Windows NT 4.0/2000, and Novell NetWare 

servers to provide printing services to users. 

• The Printing Guide describes the printing features of the E-820 for users who send 

jobs from their computers.

• The Color Guide provides information on managing the color output of the E-820. 

It explains how to calibrate your copier and take advantage of the EFI Fiery 

ColorWise® color management system, as well as features in ColorWise Pro Tools™. 

• The Fiery Color Reference addresses concepts and issues associated with managing 

color output of the E-820 and outlines key workflow scenarios. In addition, it offers 

information on printing color documents from popular Microsoft Windows and 

Apple Mac OS applications.

• The Job Management Guide explains the functions of the job management utilities, 

including EFI Command WorkStation™ and EFI Fiery DocBuilder Pro™, and how 

you can use them to monitor and control jobs on the E-820. This manual is 

intended for an operator or administrator, or a user with the necessary access 

privileges, who monitors and manages job flow, performs color calibration, and 

troubleshoots problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 

the problems you may encounter.

About the 
Documentation
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class A Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, and uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de l’Industrie Canada 

Cet appareil numérique de la Classe A est conforme à la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the software (“Software”) and accompanying documentation (“Documentation”) included with the Product. The 
Software is licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend 
the Software. You may, however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) you transfer to 
the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
materials, and this Agreement); (2) you retain no copies of the Software and Documentation, including copies stored on a computer; and (3) the recipient agrees 
to the terms and conditions of this Agreement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except as necessary for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to alter, disassemble, decompiler, decrypt 
or reverse engineer the Software.

Proprietary Rights

You acknowledge that the Software is proprietary to EFI and its suppliers and that title and other intellectual property rights therein remain with EFI and its 
suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.



Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE 
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, 
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software in any form in violation of any applicable laws or regulations of the United States or the country in 
which you obtained them.

U.S. Government Restricted Rights:

The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable.

General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with 
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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xi Introduction

This manual describes how to install user software for the Color Controller E-820, 

and how to set up printing from Microsoft Windows and Apple Mac OS 

computers. For information about setting up network servers and clients to use the 

Color Controller E-820, see the Configuration Guide. For general information on 

using the color copier, your computer, application software, or network, see the 

manuals that accompany those products.

NOTE: The term “E-820” is used to refer to the Color Controller E-820. The name 

“Aero” is used in illustrations to represent the E-820. The term “Windows 9x/Me” is 

used to represent Windows 95, Windows 98, and Windows Me.

The E-820 includes support for EFI Fiery WebTools™ and software for Command 

WorkStation, which enables an operator to manage all jobs sent to the E-820. 

Although it may not be the case at all sites, the documentation for this product 

assumes the presence of an operator who controls and manages jobs sent by users 

from remote workstations.

Additional connectivity or administrative features specific to the copier are described 

in the accompanying documentation.

About this manual
This manual covers the following topics:

• Installing printer files on Windows and Mac OS computers

• Setting up printing connections on Windows and Mac OS computers

• Installing Fiery utilities/other user software on Windows and Mac OS computers

Specifications
• 866 MHz Intel Pentium III CPU

• 512MB RAM

• 40GB hard disk drive

• An internal CD-ROM drive

Introduction
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• A 250MB ZIP drive for removable media

• Supports AppleTalk, TCP/IP, and IPX/SPX protocols simultaneously

• Supports Port 9100

• Supports twisted pair (Fast Ethernet 100BaseTX or Ethernet 10BaseT)

• Supports Adobe PostScript 3

• Includes 136 fonts (126 Adobe Type 1 PostScript and 10 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 

substitution in PDF files.

• Built-in ColorWise color management and NetWise™ networking management

• Fiery WebTools, including EFI Fiery WebStatus™, EFI Fiery WebSpooler™, EFI 

Fiery WebLink™, EFI Fiery WebInstaller™, EFI Fiery WebDownloader™, and EFI 

Fiery WebScan™

• Fiery utilities, including EFI Fiery Downloader™, EFI Fiery Link™, EFI Fiery 

Scan™, EFI Fiery Remote Scan™, EFI Fiery VDP Resource Manager™, and EFI 

Fiery Spooler™ (Mac OS only)

• ColorWise Pro Tools

• Command WorkStation (Windows only) software

• EFI Fiery Graphic Arts Package™ (available as an option)

• Supports EFI FreeForm™ and EFI Fiery FreeForm 2

• Supports Token Ring networking (available as an option)

For details, see your copier representative.

• Supports DocBuilder Pro (available as an option)

• Supports Pageflex Persona Variable Data package (available as an option)

• Supports PrintShop Mail Variable Data package (available as an option)

• Supports the Fiery Advanced Controller Interface kit (available as an option), which 

includes a monitor, a keyboard, and mouse
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• Supports Internet Printing Protocol (IPP) for Windows 98, Windows Me, and 

Windows 2000/XP

• Supports E-mail printing

• Supports scanning to E-mail

NOTE: Fiery utilities and E-820 user software can be installed on the E-820 from the 

User Software CD if the Fiery Advanced Controller Interface is installed. Other third-

party applications are not supported and may cause system problems.

User software
E-820 user software is provided on the User Software CD.  

Adobe PostScript 

Printer Driver

Enables you to print to the E-820 from 

Windows 9x/Me, Windows NT 4.0, and Mac OS 

computers; also supports E-820 and PostScript 3 

features. Windows 2000/XP users should use the 

Microsoft PostScript Printer Driver provided with 

those operating systems.

PostScript Printer 

Description (PPD) file 

For use with the PostScript printer driver that allows 

the E-820 to appear in the Print and Page Setup dialog 

boxes of popular applications. The E-820 PPDs 

provide information about the E-820 and your 

particular copier model to the application and printer 

driver you are using.

PostScript Fonts

(Mac OS only) 

PostScript screen and printer fonts that correspond 

to the 136 PostScript printer fonts installed on the 

E-820 (126 Adobe Type 1 and 10 TrueType). For a 

complete list of PostScript fonts installed on the E-820, 

see Appendix B of the Printing Guide. 
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Fiery Downloader Enables you to print PostScript files, Encapsulated 

PostScript (EPS) files, TIFF version 6.0 files, and 

Portable Document Format (PDF) versions 1.2 and 

1.3 files directly to the E-820 without opening the 

application in which they were created. You can also 

use it to manage the printer fonts installed on the 

E-820.

Fiery Spooler 

(Mac OS only)

Enables you to view the order and priority of print 

jobs, customize printer settings for jobs, delete jobs, 

and move jobs between queues. You can also use it to 

view job accounting information.

ColorWise Pro Tools ICC-open color management and calibration tools; 

enables you to edit and download ICC profiles.

Fiery Scan, 

Fiery Remote Scan

Plug-in modules for supported TWAIN-compliant 

application software that enable you to scan images 

from the copier directly into the application.

Fiery Link Enables you to monitor the status of connected E-820 

servers and the print jobs sent to them.

Fiery VDP Resource 

Manager

Allows you to look for and delete global objects used in 

variable printing.

Command WorkStation 

(Windows only)

Enables the operator to control the E-820 functions 

from Windows 9x/Me and Windows NT/2000/XP 

computers. To use Command WorkStation, see the Job 

Management Guide.

EFI Fiery Mail Port 

(Windows only)

Enables you to send jobs to the E-820 in the form of 

e-mail attachments by adding the EFI Fiery Mail Port 

software as a printer port.
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NOTE: You can install PostScript printer drivers and printer description files from 

the User Software CD or from the E-820 with the Installer WebTool. For instructions, 

see “Using the Fiery WebTools Installer” on page 2.

Fiery Graphic Arts Package 

(available as an option)

Includes Hot Folders, TIFF-IT Converter, Calibrator, 

and Custom Halftones Calibration files.

• Hot Folders—Enables one-time set up of a group of 

print options, which can be applied to any print job.

• TIFF-IT Converter—Converts files to PostScript or 

EPS for printed output on the E-820.

• Calibrator files—Enables calibration of the E-820 in 

Halftone Screen mode.

Color management files ICM (Windows) and ColorSync (Mac OS) color 

management files that enable you to maintain 

consistent color from your original artwork to the 

colors displayed on your monitor and then to the 

printed output.

Color reference files Reference pages that you can print to view the range of 

colors available on your E-820. For the most 

predictable color results, refer to these pages when 

defining colors in applications. For more information 

on color management, see the Color Guide.

Calibration files Includes measurement files and targets that you can use 

with ColorWise Pro Tools.

MRJ (Mac OS only) Mac OS Runtime for Java (MRJ) is required by all 

Java-based Fiery utilities. If MRJ is not detected when 

you install these utilities, the MRJ installer is 

automatically launched.
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WebTools
Fiery WebTools allow you to manage your E-820 remotely from the Internet or from 

your company’s intranet. You access WebTools from the WebTools home page.

NOTE: To find out which WebTools are supported, see “Specifications” on page xi. 

section.

System requirements
System requirements are described in detail in the printed Quick Start Guide provided 

in your media pack.

WebTool Summary For more information

Status Shows you the jobs currently processing 
and printing.

See the Printing Guide.

WebSpooler Allows you to view, manipulate, reorder, 
reprint, and delete jobs currently 
spooling, processing, or printing on the 
E-820. It also allows you to view, print, 
and delete the Job Log.

See the Job Management 
Guide.

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection.

See the Printing Guide and 
the Configuration Guide.

Installer Allows you to download the Fiery Link 
installer and E-820 printer file installers 
directly from the server.

See Chapter 3.

WebDownloader Allows you to download PostScript, 
EPS, and PDF files to the E-820.

See the Printing Guide.

WebScan Allows you to view and print images that 
have been scanned to the copier.

See the Printing Guide.
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This chapter describes the procedures for installing software and setting up printing 

from a computer using a supported version of Windows. For Windows versions 

supported, see the Quick Start Guide. 

The general steps for installing the software are as follows: 

• Install the PostScript printer driver and corresponding printer driver files and set up 

the printer driver to communicate with the E-820.

• Install Fiery utilities and user software—Fiery Graphic Arts Package (available as an 

option), EFI Fiery Mail Port, Fiery Scan, Fiery Remote Scan, Fiery Link, Fiery 

Downloader, Fiery VDP Resource Manager, ColorWise Pro Tools, and Command 

WorkStation.

• Configure the connection for Fiery utilities and user software.

• Copy additional files from the User Software CD as required.

In addition to using the User Software CD, you can download printer drivers and the 

Fiery Link installer from the E-820 with the Installer WebTool (if the administrator 

has enabled Internet access to the E-820). For instructions, see “Using the Fiery 

WebTools Installer” on page 3-2. Once you download the printer files, the installation 

process is identical to installing from the User Software CD.

Setting up PostScript printing with Windows 9x/Me
To set up the E-820 as a PostScript printer, you must install the PostScript printer 

driver for Windows 9x/Me and the corresponding printer description files. You must 

also configure either a local connection for printing directly or a network connection 

for printing over the network. 

If you are printing using SMB (Server Message Block), you can connect to the E-820 

and install the printer drivers in a single procedure. For more information, see “Setting 

up SMB printing with Windows 9x/Me” on page 1-9.

Chapter 1:
Installing 
User Software 
on a Windows 
Computer
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Installing the PostScript printer driver for Windows 9x/Me

The following procedure describes installing the printer driver from the User 

Software CD or from the Installer WebTool. Subsequent procedures describe 

configuring installable options and setting up the printer connection.

NOTE: The following procedures use Windows 98 illustrations; Windows 95 and 

Windows Me differences are noted.

TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 

connection later, according to your network type.

4. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.

5. If you are installing from the CD, type the name of the CD-ROM drive (for example, 

D:\), and click Browse. Browse to English\Prntdrvr\Ps_drvr\Win_9x_ME. 

If you are installing from the files you downloaded using the Installer WebTool, 

browse to prntdrvr\Prntdrvr\Ps_drvr\Win_9x_ME.

6. Make sure “Oemsetup.inf” is selected and click OK. 

The path is copied to the Install From Disk dialog box.

7. Verify the path is correct and click OK.
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8. Select the E-820 printer driver appropriate for your printer and click Next.

9. Select the LPT1 port and click Next.

You will configure the port later, according to your network type.

10. Enter a name for the E-820.

11. To make the E-820 the default printer, select Yes; if not, select No. Click OK 

(Windows 95) or Next (Windows 98/Me).

12. Select No to printing the test page and click Next (Windows 95) or Finish 

(Windows 98/Me).

The necessary files are installed to your computer.
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Configuring installed options

After you have completed the printer driver installation, you must configure the E-820 

for the options installed on the copier. This allows the E-820 to take advantage of the 

copier options. You can configure the options manually; or for TCP/IP network 

connections, you can use the Two-Way Communication feature to configure the 

options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the E-820 for the 

options installed on the copier.

TO CONFIGURE OPTIONS MANUALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the E-820 icon and choose Properties from the File menu. 

3. Select the Configuration tab.

4. Select an installed option from the Available Options list.

5. Click Add to move the option to the Installed Options list.
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GA Features—Not Installed, Installed

Large Capacity Tray (LCT)—Not Installed, Installed

Sorter—Not Installed, Installed

6. Click Apply.

Configuring installed options and updating print options settings 
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 

driver to reflect the options currently installed on the copier. When the printer driver is 

first installed, the options have default settings that were set up in E-820 Setup. When 

you update the printer driver with the Two-Way Communication feature, you allow 

the E-820 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 

reflect the current color settings on the E-820. To access the Expert Color Settings 

options, click the Expert Settings tab in the ColorWise print option bar of the Fiery 

printing tab of your printer driver. For more information, see the Color Guide.

TO CONFIGURE INSTALLED OPTIONS AND UPDATE PRINT OPTIONS 
SETTINGS AUTOMATICALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the E-820 PostScript printer driver. 

3. Choose Properties from the File menu.

4. Select the Configuration tab.
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5. Select Two-Way Communication.

6. Enter the E-820 IP address or DNS name.

7. To display the printer’s current default settings when opened, select Update Fiery 

Driver When Opened.

8. Click Update, and then click OK.

Completing the Windows 9x/Me printer connection

To print from Windows 9x/Me, you should already have set up network servers, if any, 

and set up the E-820 to accept print jobs from your computer.

To complete the Windows 9x/Me connection, you must configure a connection on 

each Windows computer for the network.

Completing the Windows 9x/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 

be set up before you begin. The file server should be configured with a print server and 

print connection for the E-820. For details, see your NetWare documentation and the 

Configuration Guide.

Two-Way Communication
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To print from Windows 9x/Me computers over IPX (Novell), you must first set up 

IPX/SPX protocols, and then configure the E-820 by choosing the IPX frame type and 

entering the settings for the port you use.

TO SELECT A FRAME TYPE FOR IPX/SPX PRINTING FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the installed network 

components pane.

For instructions, see your Windows 9x/Me documentation or contact Microsoft 

Technical Support.

3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. Select Frame Type in the Property list. 
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6. In the Value menu, select the Frame Type that corresponds to the one set in E-820 

Network Setup.

If necessary, print the Configuration page from the E-820 Control Panel to determine 

which frame type(s) are configured.

NOTE: Do not select Auto. Doing so may not select the frame type specified on 

the E-820.

7. Click OK and close the Network Control Panel.

8. When prompted to restart your computer, click Yes.

TO SET UP A PORT FOR IPX (NOVELL) PRINTING WITH WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the E-820 printer icon and choose Properties from the File menu.

3. Click the Details tab and click Add Port.

A list of connection options appears.
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4. In the Add Port dialog box, specify the network path or click Browse for a display of 

your network environment.

5. If you are using a NetWare file server, double-click the icon for the NetWare file server 

to use for printing to the E-820. 

6. Click the printer icon for the NetWare print queue you want to use and click OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server. 

The E-820 polls the file server, and if jobs are present, they are transmitted to 

the E-820.

8. To confirm the connection, click the General tab, click Apply, and then click Print 

Test Page.

After the test page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 9x/Me

SMB printing (also known as Windows or WINS printing) allows you to install the 

PostScript printer driver and printer description files on your computer from the 

E-820 using Point and Print, and print to a particular connection (Hold, Print, or 

Direct). To set up SMB printing, you must have the TCP/IP protocol and Client for 

Microsoft Networks installed.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 

description file. Repeat the procedure “To set up SMB printing on Windows 9x/Me”. 

If you install more than one printer, give each a descriptive name during printer driver 

installation, such as Aero-Print or Aero-Hold, so you can easily identify printers.

BEFORE YOU BEGIN

• Configure the E-820 for SMB printing in Run Setup>Network Setup > Service Setup >  

Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 

and on the Configuration page. 
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TO SET UP SMB PRINTING ON WINDOWS 9X/ME

1. Double-click the Network Neighborhood icon to display your network environment.

2. Browse for the printer you want to print to.

Browse for the name entered in Network Setup>Service Setup>Windows 

Setup>Server Name. For this information, see the Configuration page.

NOTE: You can also locate the printer using the Find feature on your Windows 

computer. Click Start, choose Find, and then choose Computer. Enter the name of the 

printer, and click Find Now.

If you are not able to locate your E-820, contact your network administrator.

3. Double-click the name of the printer to display enabled print connections.

NOTE: For a description of each print connection, see the Configuration Guide.

4. Double-click the name of the connection you want to print to.

5. Select Yes to install the PostScript printer driver and printer description file for 

the selected connection.

The Add Printer Wizard appears.

6. Specify whether you print from MS-DOS based programs and click Next.

If you choose Yes, you must capture a printer port before proceeding with the 

installation. For details, see your Windows documentation.
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7. Enter a name for the E-820 in the Printer name field and choose whether to make it 

the default printer. Click Next.

8. If you want to print a test page, choose Yes and click Finish.

The necessary files are installed to your computer. 

If the test page prints successfully, you are ready to print from the computer.

Setting up IPP printing with Windows 9x/Me

With Internet Printing Protocol (IPP), print jobs are sent to the E-820 over 

the Internet.

IPP printing is supported on Windows 2000/XP but can be enabled on 

Windows 9x/Me computers by installing the “wpnpins.exe” client file (available on the 

Windows Me CD or the Windows 2000 Server CD). For more information about 

obtaining and installing this client, contact the Microsoft Corporation or Microsoft 

Technical Support.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 

drivers (see “To install the PostScript printer driver for Windows 9x/Me” on page 1-2).

BEFORE YOU BEGIN

1. Prepare the E-820 for TCP/IP printing.

2. Make sure the E-820 is configured for IPP printing. 

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.
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TO SET UP IPP PRINTING WITH WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers windows, right-click the icon for the E-820 PostScript printer driver 

and select Properties.

3. Select the Details tab and click Add Port.

The Add Port dialog box appears.

4. Enter the network path for the printer.

The path for the printer is the IP address or the DNS name, followed by ipp, and then 

by the Fiery connection you want to print to (print, hold, or direct). Insert slashes 

between the elements, for example, http://10.10.10.150/ipp/print.

5. Click OK. 
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Setting up PostScript printing with Windows NT 4.0

To set up the E-820 as a PostScript printer, you must install the PostScript printer 

driver for Windows NT 4.0 and the corresponding printer description files. You must 

also configure the print connection between the computer and the E-820. If you are 

printing over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows NT 4.0

The following procedures describe the installation of a local printer. Adding a printer 

to a local system requires that you log in to your local Windows NT 4.0 computer 

(not the network server domain) and that you are a member of the Administrators 

group. The procedure for adding a network printer is similar to adding a port (see 

“Completing the Windows NT 4.0 TCP/IP and LPR connection” on page 1-19).

TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS NT 4.0

1. If you are installing from the User Software CD, insert it into the CD-ROM drive.

2. Click Start, choose Settings, and then choose Printers.

3. Double-click Add Printer.

4. To install a printer locally, select My Computer and click Next.

My Computer is available if you logged in to a computer on which you have 

Administrator privileges. If it is not available, you can add a network printer. 

The procedure is similar to adding a port (see page 1-20).
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5. Select LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add 

a network port later, according to your network type.

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.

7. If you are installing from the CD, type the name of the CD-ROM drive (for example, 

D:\) and click Browse.

If you are installing from files you downloaded using the Installer WebTool, type the 

name of your hard disk drive (for example, C:\) and click Browse.

8. If you are installing from the CD, browse to the English\Prntdrvr\Ps_drvr\Win_NT4x 

folder and click Open.

If you are installing from files you downloaded using the Installer WebTool, browse to 

the prntdrvr\Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install From Disk dialog box.
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9. Verify that the path is correct and click OK.

10. In the Printers box, select the E-820 printer driver appropriate for your printer and 

click Next.

11. Type a name for the E-820 in the Printer name field and indicate whether you want to 

make it the default printer. Click Next.

12. Indicate whether you want the printer installed as a shared printer, and click Next.

If you select Shared, enter a Share Name for the printer and select the operating 

systems used by client computers. For information on shared printers, see the 

Configuration Guide.

13. Click No to postpone printing a test page and click Finish.

When installation is complete, the Printers window is displayed with an icon for the 

newly installed printer.
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Configuring installed options

After you have completed the printer driver installation, you must configure the E-820 

to reflect the options installed on the copier. This allows the E-820 to take advantage 

of the copier options. You can configure the options manually; or for TCP/IP network 

connections, you can use the Two-Way Communication feature to configure the 

options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the E-820 for the 

options installed on the copier.

TO CONFIGURE INSTALLABLE OPTIONS ON THE E-820 FROM THE POSTSCRIPT 
PRINTER DRIVER FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers. 

2. Click the E-820 icon and choose Properties from the File menu.

3. Click the Device Settings tab and scroll to Installable Options. 
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4. Select an Installable Option and choose a setting.

NOTE: Windows NT systems display installable options as a menu. You must select the 

installable option to activate the menu.

GA Features—Not Installed, Installed

Large Capacity Tray (LCT)—Not Installed, Installed

Sorter—Not Installed, Installed

5. Click OK to activate the current settings.

You are ready to connect to your network type (see “Completing the Windows NT 4.0 

printer connection” on page 1-19).

Configuring installed options and updating print options settings 
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 

driver to reflect the options currently installed on the E-820. When the printer driver 

is first installed, the installable options have default settings that were set up in 

E-820 Setup or ColorWise Pro Tools. When you update the printer driver with the 

Two-Way Communication feature, you allow the E-820 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 

reflect the current color settings on the E-820. To access Expert Color Settings options, 

click the Expert Settings tab in the ColorWise print option bar of the Fiery printing 

tab of your printer driver. For more information, see the Color Guide.

SETTING UP TWO-WAY COMMUNICATION FOR POSTSCRIPT 
PRINTER DRIVERS FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the E-820 PostScript printer driver. 

3. Choose Properties from the File menu.
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4. Click the Configuration tab.

5. Select Two-Way Communication.

6. Enter the E-820 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select 

Update Fiery Driver When Opened.

8. Click Update.

9. Click OK.

Two-Way Communication
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Completing the Windows NT 4.0 printer connection

To print from Windows NT 4.0, you must:

• Set up network servers, if any.

• Set up the E-820 to accept print jobs from your computer.

• Configure a port on each Windows NT 4.0 computer for the network type.

Completing the Windows NT 4.0 TCP/IP and LPR connection

After you have installed the PostScript printer driver and printer driver files, complete 

the setup for the TCP/IP and LPR connection as follows:

• Prepare the E-820 to accept print jobs using TCP/IP and LPR protocols. 

For details, see the Configuration Guide.

• Enable LPD from the E-820 Control Panel. 

For details, see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to 

the E-820, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on your Windows NT computer.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP 
and LPR connection” on page 1-19

Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX 
(Novell) connection” on page 1-21
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TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the E-820 and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and 

Microsoft TCP/IP printing software. See your Windows documentation.

4. Enter the IP address of the E-820. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 

the E-820 instead of the IP address.

5. Press Tab and type one of the following names, depending on the E-820 connection 

you want to print to.

print

hold

direct

NOTE: This name is case-sensitive; type it exactly as shown.
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6. Click OK.

The computer checks the address or DNS name you entered and notifies you if it 

cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must close the Printer 

Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.

10. Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 

the E-820.

11. Click OK to close the Printer Properties dialog box.

Completing the Windows NT 4.0 IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling E-820 print jobs. The file 

server should be configured with a print server and print connection for the E-820. 

For details, see your NetWare documentation.

• Prepare the E-820 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 

services should already be installed on the Windows NT 4.0 computer.
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TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 

defined a print connection for the E-820.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the E-820.

5. If the NetWare server does not have a suitable driver for the E-820, you may be asked 

if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the E-820 PostScript printer driver.

7. Follow the procedure on page 1-14, steps 6 through 13.

When installation is complete, a new printer window appears, with the name of the 

print queue on the NetWare server.
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8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 

the E-820.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes window, enter user and job identification information and 

click OK.

The Test Page remains listed in the queue window until it is printed.

The E-820 polls the NetWare server for print jobs in the print connection defined for 

the E-820. When you print, your PostScript files are spooled to that connection and 

transmitted over the queue “port” to the E-820. 



11-24 Installing User Software on a Windows Computer

Setting up SMB printing on Windows NT 4.0

SMB printing (also known as Windows printing) allows you to install the PostScript 

printer driver and printer description files, and print from your computer to a 

particular print connection (Hold, Print, or Direct) on the E-820. These instructions 

assume you have installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 

description file. To set up printing to a second or third print connection, repeat the 

procedure “To set up SMB printing on Windows NT 4.0” on page 1-25. If you install 

more than one printer, give each a descriptive name during printer driver installation, 

such as Aero-Print or Aero-Hold, so you can easily identify printers.

NOTE: To change printer defaults and configure installable options from Windows 

NT 4.0, you must log on as Administrator and use the password specified in E-820 

Setup. If you log on as a User, you can install the printer driver through Point and 

Print, but you cannot modify printer defaults and configure installable options.

BEFORE YOU BEGIN

• Configure the E-820 for SMB printing in Run Setup>Network Setup>Service Setup> 

Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 

and on the Configuration page. For more information, see the Configuration Guide.
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TO SET UP SMB PRINTING ON WINDOWS NT 4.0

1. Double-click Network Neighborhood.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup> 

Service Setup>Windows Setup>Server Name. For this information, see the 

Configuration page.

The amount of network traffic determines the amount of time required for the 

Browse function.

NOTE: You can also locate the printer with the Find feature on your Windows 

computer. Click Start, choose Find, and then choose Computer. Enter the name 

of the printer, and click Find Now.

If you are not able to locate your E-820, contact your network administrator.
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3. Double-click the name of the E-820 to display enabled print connections.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set up the printer.

5. Select Yes to complete the installation for the selected connection.

Windows NT 4.0 downloads the printer driver and printer description files from the 

E-820 to your computer and installation is complete.

Setting up PostScript printing with Windows 2000/XP
To set up the E-820 as a PostScript printer, you must install the PostScript printer 

driver for Windows 2000/XP and the corresponding printer description files. 

You must also configure the print connection between the computer and the E-820. If 

you are printing over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows 2000/XP

The following procedure describes installing the printer driver from the User 

Software CD or from the Installer WebTool. Subsequent procedures describe setting 

up the print connection.

NOTE: The following procedures use Windows 2000 illustrations; Windows XP 

differences are noted. 
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TO INSTALL THE POSTSCRIPT PRINTER DRIVER FOR WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers to display the 

Printers window. 

On Windows XP, click Start and choose Printer and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next.

On Windows XP, click Add Printer.

3. Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the 

connection later, according to your network type.

4. Select LPT1: and click Next.

5. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.
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6. Type the name of the CD-ROM drive (for example, D:\) and click Browse. Browse to 

the English\Prntdrvr\Ps_drvr\Win_2000 or English\Prntdrvr\Ps_drvr\Win_XP folder.

If you are installing from the files you downloaded using the Installer, browse to 

prntdrvr\Prntdrvr\Ps_drvr\Win_2000 or prntdrvr\Prntdrvr\Ps_drvr\Win_XP and click 

Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open. 

7. Verify the path is correct and click OK.

The path is copied to the Install From Disk dialog box.

8. In the Printers box, select the E-820 printer driver appropriate for your printer and 

click Next.
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9. Type a name for the E-820 in the Printer name field.

This name will be used in the Printers window and the queues window.

10. Follow the instructions in the remaining windows.

When asked whether to print a test page, select No.

The necessary files are installed to your hard disk.

11. If this is the first printer driver you are installing on the computer, you may be 

prompted to install files from the Windows 2000 CD. Insert the CD-ROM, browse to the 

win2000\english\i386 folder, and then click OK.

When installation is complete, the Printers window appears with an icon for the newly 

installed printer. You must now configure the options installed on your copier.
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Configuring installed options

After you have completed the printer driver installation, you must configure the E-820 

to reflect the options installed on the copier. This allows the E-820 to take advantage 

of the copier options. You can configure the options manually; or for TCP/IP network 

connections, you can use the Two-Way Communication feature to configure the 

options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the E-820 for the 

options installed on the copier.

TO CONFIGURE INSTALLABLE OPTIONS ON THE E-820 FROM THE POSTSCRIPT 
PRINTER DRIVER FOR WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers. 

On Windows XP, click Start, and choose Printers and Faxes.

2. Click the E-820 icon and choose Properties from the File menu.

3. Click the Configuration tab.

4. Select an installed option from the Available Options list.
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5. Click Add to move the option to the Installed Options list.

GA Features—Not Installed, Installed

Large Capacity Tray (LCT)—Not Installed, Installed

Sorter—Not Installed, Installed

6. Click OK to activate the current settings.

You are ready to connect to your network type (see “Completing the Windows NT 4.0 

printer connection” on page 1-19).
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Configuring installed options and updating print options settings 
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer 

driver to reflect the options currently installed on the E-820. When the printer driver 

is first installed, the installable options have default settings that were set up in 

E-820 Setup or ColorWise Pro Tools. When you update the printer driver with the 

Two-Way Communication feature, you allow the E-820 to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to 

reflect the current color settings on the E-820. To access the Expert Color Settings 

options, click on the Expert Settings tab in the ColorWise print option bar of the Fiery 

printing tab of your printer driver. For more information, see the Color Guide.

SETTING UP TWO-WAY COMMUNICATION FOR POSTSCRIPT PRINTER 
DRIVERS FOR WINDOWS 2000/XP

NOTE: The procedures for Windows 2000 and XP are similar. The following procedure 

uses Windows 2000 illustrations.

1. On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, and choose Printers and Faxes.

2. In the Printers window, select the icon for the E-820 PostScript printer driver. 

3. Choose Properties from the File menu.

4. Click the Configuration tab.
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5. Select Two-Way Communication.

6. Enter the E-820 IP address or DNS name.

7. If you want your printer driver to display the current settings when opened, select the 

Update Fiery Driver When Opened option.

8. Click Update.

9. Click OK.
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Completing the Windows 2000/XP printer connection

To print from Windows 2000/XP, you must:

• Set up network servers, if any.

• Set up the E-820 to accept print jobs from your computer.

• Configure a port on each Windows 2000/XP computer for the network type.

NOTE: The procedures for completing the printer connection for Windows 2000 

and Windows XP are similar. Windows 2000 illustrations are used, with relevant 

Windows XP differences noted.

Completing the Windows 2000/XP TCP/IP and Port 9100 or LPR connection

Once you have installed the PostScript and printer driver files, complete the setup 

for the TCP/IP and LPR connection as follows:

• Prepare the E-820 to accept print jobs using TCP/IP and LPR protocols. 

For details, see the Configuration Guide.

• Enable LPD or Port 9100 from the E-820 Control Panel. 

For details, see the Configuration Guide.

• Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to 

the E-820, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on the Windows 2000/XP 

workstation.

To do this See

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP 
and LPR connection” on page 1-19

Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX 
(Novell) connection” on page 1-21
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NOTE: You can also set up the LPR connection by installing Print Services for UNIX, 

which is supplied as an add-on Windows component with your Windows 2000/XP 

CD. For more information, see your Windows documentation.

TO SET UP TCP/IP AND PORT 9100 OR LPR CONNECTION FOR 
WINDOWS 2000/XP

1. Open the Properties dialog box for the E-820 and click the Ports tab.

2. Click Add Port.

3. Select Standard TCP/IP Port for Available port types and click New Port.

4. Click Next. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

5. Enter the IP address of the E-820.

6. Click Next.

7. Make sure that Generic Network Card is selected as Standard for Device Type and click 

Next.

8. Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and click 

Close in the Printer Ports dialog box.
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9. Click Configure Port in the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.

10. If you have LPD printing enabled at the E-820 Control Panel, select LPR for Protocol 

and LPR Byte Counting Enabled under LPR Settings.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled under 

LPR settings.

11. If you have Port 9100 printing enabled at the E-820 Control Panel, select Raw. 

The port number 9100 automatically appears under Raw Settings. You can print to the 

printer connection selected for Port 9100 printing at the E-820 Control Panel.

12. Enter the name of the print connection.

For LPR, use print or hold.

For Port 9100, manually enter the following port numbers for each print connection 

under Raw Settings:

direct: 9101

print: 9100 (default) or 9102

hold: 9103

13. Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.
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Completing the Windows 2000/XP IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling E-820 print jobs. The file 

server should be configured with a print server and print connection for the E-820. 

For details, see your NetWare documentation.

• Prepare the E-820 for IPX printing.

• Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 

services should already be installed on the Windows 2000/XP computer.

TO SET UP IP X (NOVELL) PRINTING FOR WINDOWS 2000/XP

1. Double-click My Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3. Double-click the NetWare Tree or File Server on which the network administrator 

defined a print connection for the E-820.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the E-820.
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5. If the NetWare server does not have a suitable driver for the E-820, you may be asked 

if you want to set up the printer on your computer. Click Yes.

6. Click OK to install the E-820 PostScript printer driver.

7. Follow the procedure on page 1-14, steps 6 through 13.

When installation is complete, a new printer window appears, with the name of the 

print queue on the NetWare server.

8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 

the E-820.

9. Click the General tab and click Print Test Page.

10. In the printer Job Notes window, enter user and job identification information and 

click OK.

The Test Page remains listed in the queue window until it is printed.

The E-820 polls the NetWare server for print jobs in the print connection defined for 

the E-820. When you print, your PostScript files are spooled to that connection and 

transmitted over the queue “port” to the E-820.
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Setting up SMB printing on Windows 2000/XP

SMB printing (also known as Windows printing) allows you to install the printer 

driver and associated files, and print from your computer to a particular print 

connection (Hold, Print, or Direct) on the E-820. These instructions assume you have 

installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer 

description file. To set up printing to a second or third print connection, repeat the 

following procedure, “To set up SMB printing on Windows 2000/XP”. If you install 

more than one printer, give each a descriptive name during printer driver installation, 

such as Aero-Print or Aero-Hold, so you can easily identify printers.

NOTE: With Windows 2000/XP, the printer driver must be installed from the User 

Software CD. You cannot use Point and Print to install the driver and configure the 

printing connection to the E-820 in a single procedure.

BEFORE YOU BEGIN

• Configure the E-820 for SMB printing in Network Setup>Service Setup> 

Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 

and on the Configuration page. For more information, see the Configuration Guide.

TO SET UP SMB PRINTING ON WINDOWS 2000/XP

1. Open My Network Places.

2. Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup> 

Service Setup>Windows Setup > Server Name. For this information, see the 

Configuration page.

The amount of network traffic determines the amount of time required for the 

Browse function.

NOTE: You can also locate the printer using the Search feature on your Windows 

computer. Right-click My Network Places and click Search for Computers. 

Enter the name of the printer and click Search Now.
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If you are not able to locate your E-820, contact your network administrator.

3. Double-click the name of the E-820 to display enabled print connections.

You must now create a printer port and install the printer driver from the User 

Software CD.

NOTE: You cannot use Point and Print to install the driver and configure the printing 

connection to the E-820 in a single procedure.

4. On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start and choose Printers and Faxes.

5. Double-click Add Printer and click Next.

6. Click Local Printer and click Next.

7. Click Create a New Port, and select Local Port from the menu. Click Next.

8. In the Port Name dialog box, enter the name of the E-820, followed by the printing 

connection, and click OK.

Enter the port name as follows: \\Aero\print where Aero is the name of the E-820 and 

print is the printing connection.

9. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

You will now install the printer driver from the User Software CD.

10. Enter the name of the CD-ROM drive and browse to the 

English\Prntdrvr\Ps_drvr\Win_2000 or English\Prntdrvr\Ps_drvr\Win_XP folder.

11. Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open.

12. Verify the path is correct in the Install From Disk dialog box and click OK.

13. Follow the on-screen instructions.

For more information, see “To install the PostScript printer driver for 

Windows 2000/XP” on page 1-27.
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Setting up IPP printing with Windows 2000/XP

With Internet Printing Protocol (IPP), print jobs are sent to the E-820 over 

the Internet.

IPP printing is supported directly for Windows 2000/XP computers. IPP printing is 

not supported on Windows NT 4.0.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 

drivers (see “To install the PostScript printer driver for Windows 2000/XP” on 

page 1-27).

BEFORE YOU BEGIN

1. Prepare the E-820 for TCP/IP printing.

2. Make sure the E-820 is configured for IPP printing in Network Setup > Service 

Setup > IPP Setup. 

For more information, see the Configuration Guide.

3. Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start and choose Printers and Faxes.

2. On Windows 2000, double-click the Add Printer icon and click Next

On Windows XP, click Add Printer.

3. Select Network printer and click Next.
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4. Select “Connect to a printer on the Internet or on your intranet.” Enter an IP address 

or computer name in the URL window.

The URL for the printer is the IP address or DNS name followed by “ipp” and the 

connection you want to print to (print, hold, or direct). Insert slashes between the 

different elements.

5. Click Next.

The Connect to Printer dialog box appears.

6. Click OK.

The Add Printer Wizard dialog box appears. 

7. If you are installing the PostScript printer for Windows 2000/XP for the first time, 

follow the procedure on page 1-27.

If you have already installed the printer driver on your computer, choose Ricoh for 

Manufacturers and E-820 R7 Color Server US or E-820 R7 Color Server for Printers and 

click OK. 

8. Indicate whether you want to make the E-820 the default printer and click Next.

9. Click Finish.
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Installing EFI Fiery Mail Port
The e-mail service provides a method to print and control the E-820 remotely. Jobs are 

sent to the E-820 in the form of e-mail attachments. You can set up e-mail printing on 

Windows computers by adding the EFI Fiery Mail Port software as a printer port.

To set up the E-820 for e-mail printing, see the Configuration Guide. After Setup has 

been performed, install the software from the User Software CD onto your Windows 

computer, and then add a port.

NOTE: The following procedures are similar for all Windows platforms. 

The illustrations shown are Windows NT 4.0.

TO INSTALL THE E-MAIL PORT MONITOR ON WINDOWS COMPUTERS

1. Open the EFI Fiery Mail Port folder on the User Software CD.

2. Double-click the Setup icon and follow the instructions.

When installation is complete, you are ready to configure the connection for the e-mail 

port monitor.

TO CONFIGURE THE CONNECTION FOR THE EFI FIERY MAIL PORT

1. Click Start, choose Settings, and then choose Printers.

2. In the Printers window, double-click the Add Printer icon and click Next.

3. Specify printing using a Local printer and click Next.
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4. In the window displaying a list of ports, click Add Port.

The Printer Ports dialog box is displayed, with the EFI Fiery Mail port listed as one of 

the available ports. 

5. Select EFI Fiery Mail and click New Port. 

The Add Port dialog box appears.

6. Enter the basic information required to set up the e-mail port. 

Fiery’s E-mail Address—Enter the e-mail address of the E-820.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port 

monitor to use.

7. Click Advanced.



11-45 Installing EFI Fiery Mail Port

The E-Mail Port Configuration dialog box appears.

8. Enter the following information.

For Fiery Server:

E-mail Address—The e-mail address of the E-820.

Queue—The print connection on the E-820 that you want.

For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.

For Options:

Break email messages larger than—The maximum size of a single e-mail message 

is displayed. If a job exceeds this size, it is split into multiple messages, each not 

exceeding this size.

Status messages from E-820—When enabled, the Status option requests the E-820 

to send status reports of the job via e-mail.
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9. Click OK.

The Add Printer Wizard dialog box appears.

10. Click Next and follow the instructions for installing the printer driver for your 

Windows computer.

Installing Fiery utilities
From the User Software CD, you can install the following Fiery utilities and user 

software:

• Fiery Link

• ColorWise Pro Tools

• Fiery Downloader

• Fiery Scan (TWAIN module)

• Fiery Remote Scan (TWAIN Fiery Scan Module)

• EFI Fiery Mail Port (see page 1-43)

• Fiery VDP Resource Manager

• Command WorkStation

• DocBuilder Pro (available as an option)

Includes PitStop, a plug-in for Adobe Acrobat 4.0.

• Fiery Graphic Arts Package (available as an option)

NOTE: If available, do not attempt to install DocBuilder Pro from the User Software 

CD (by launching the setup.exe from the DBPro folder); it is automatically installed 

when you install Command WorkStation. Installing DocBuilder Pro from the User 

Software CD can cause unpredictable results. In order to use DocBuilder Pro, you 

must install Acrobat 4.0.5 and the DocBuilder Pro dongle from the DocBuilder Pro 

option kit. To install Acrobat, see “Adobe Acrobat” on page 1-48.

The utilities must be separately installed on each user’s computer. The installation of 

each utility is similar. Before you begin each installation, determine where you want to 

install each item on your hard disk. Otherwise, the software is placed by default in the 

Fiery folder inside the Programs folder, except for Fiery Remote Scan.



11-47 Installing Fiery utilities

The Command WorkStation installer also installs the Java files necessary to use Fiery 

Setup from Command WorkStation. The Fiery Graphic Arts Package installer places a 

shortcut for Hot Folders on your Desktop.

To use E-820 software as well as WebTools on Windows XP, you must install the 

“msjavx86.exe” file in the Java VM folder on your computer. For more information on 

WebTools, see the Job Management Guide and the Printing Guide.

To install the software on a Windows 2000 computer, you must have Service Pack 2 

installed on your computer. If not, a warning message alerts you to install Service 

Pack 2.

 The TWAIN Fiery Scan and Fiery Remote Scan Module installer automatically creates 

a folder named Twain_32 in the Windows folder on your hard disk, and then installs 

the Fiery Remote Scan plug-in module into the folder.

NOTE: Before installing the TWAIN Fiery Scan or Fiery Remote Scan module, make 

sure the TWAIN plug-ins (installed with TWAIN-compliant application software) are 

located in the correct Plugins subfolder. If the TWAIN plug-ins have been deleted, you 

must reinstall the TWAIN-compliant application software in order to use Fiery Scan or 

Fiery Remote Scan.

You access the Fiery Scan or Fiery Remote Scan plug-in from the TWAIN-compliant 

application software using the TWAIN module. For details, see the Printing Guide.

TO INSTALL FIERY UTILITIES

1. Open the appropriate folder for the software you want to install.

2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation.
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Adobe Acrobat

In Command WorkStation, the DocBuilder Pro feature (available as an option) and 

PitStop software plug-in work with Adobe Acrobat v4.0.5. To use DocBuilder Pro, you 

must install Adobe Acrobat 4.0.5, the PitStop plug-in, and Command WorkStation. 

If you have purchased the DocBuilder Pro option, the Acrobat application is included 

on the Adobe Acrobat for DocBuilder Pro CD.

If Adobe Acrobat version 5.0 is already installed on your computer, version 4.0.5 will 

be installed in a separate folder. Therefore you do not need to uninstall version 5.0 to 

use DocBuilder Pro, but you must install version 4.0.5.

NOTE: If Adobe Acrobat is installed after Command WorkStation, you may be required 

to restart Command WorkStation in order to use DocBuilder Pro. 

For more information about Adobe Acrobat for Windows, see the Readme.pdf file on 

the Adobe Acrobat for DocBuilder Pro CD.

TO INSTALL ACROBAT

1. Insert the Adobe Acrobat CD in the CD-ROM drive.

The Adobe Acrobat Welcome screen appears.

2. Click Next and follow the on-screen instructions.

Using Fiery utilities for the first time

Before you can use the newly installed software, you must configure the connection to 

the E-820. Configuration of the Fiery utilities is similar. 

Configuring the connection for Fiery utilities

The first time you launch one of the Fiery utilities, you must configure the connection 

to the E-820. Similar configuration is used for all Fiery utilities (including Fiery 

Remote Scan), so any change in one configuration affects all the other connections. 

Configuration for most Fiery utilities is described in the procedure on page 1-49. 
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For configuration of specific Fiery utilities, see the following: 

• “Configuring the connection for Command WorkStation” on page 1-51

• “Configuring the connection for Fiery VDP Resource Manager” on page 1-54

• “Configuring a connection for Fiery Link” on page 1-56

BEFORE YOU BEGIN

• Print the Configuration page from the E-820 Control Panel.

This page contains information you need when configuring the connection, such as 

the IP address. For TCP/IP installations, you can use the DNS name of the E-820 

instead of the IP address. Make sure the E-820 is already registered in a Domain Name 

Server (DNS) on your network. For more information, see your Windows system 

documentation. 

TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1. Start the utility for which you want to configure a connection. 

For Fiery Scan or Fiery Remote Scan, start the supported TWAIN-compliant 

application software.

For details, see the Printing Guide.

2. If the No Servers Configured dialog box appears, click OK.

If the Choose Printer Device dialog box appears, click Add.

3. Enter the appropriate information for the E-820.

Nickname—Enter a name for the E-820. This name does not have to match the actual 

Server Name of the E-820.

NOTE: The nickname cannot contain any of the following seven characters:

[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the menu.
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NOTE: Fiery utilities are not supported over IPX/SPX. Command WorkStation is 

supported on Windows computers over TCP/IP.

Server Name—Enter the IP address (or DNS name) of the E-820.

New Device—Enter the name of the device the E-820 is connected to: r7.

4. When you have entered all the information, click Add.

5. With the device name (r7) selected in the Devices list, click OK.

The E-820 appears in the list of available servers. The first line of the entry displays the 

nickname you gave the server, followed by the protocol you chose. The second line 

displays the device name. 

6. With the device name selected in the list of Available Servers, click Select to begin 

using the utility.

Modifying the configuration

Edit the configuration whenever there is any change to your E-820 server or network, 

such as a server name or IP address. If you change E-820 Setup information, do so 

before reconfiguring the connection.

TO MODIFY THE CONFIGURATION

1. To edit information for a E-820 in the list of available servers, select the E-820 by its 

nickname and click Modify. 

2. Make the necessary changes in the Modify Server Settings dialog box and click OK. 

Device name of the E-820 (r7)
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3. To add a new E-820 to the list of available servers, click Add. Configure the Add New 

Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove a E-820, select the E-820 by its nickname and click Remove.

NOTE: The nickname cannot be modified.

Configuring the connection for Command WorkStation

The first time you start Command WorkStation, you are prompted to configure 

the connection to the E-820.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1. Print a Configuration page.

The information on this page helps you locate the E-820 if it is not on the same local 

subnet as your computer.

2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the local subnet are 

displayed. 
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3. If no E-820 servers were found, click the Manual tab to search by DNS name or 

IP address. Click Add to add the server to the Available Servers list.

4. Click the Auto Search tab and then click Advanced to search by either a range of 

IP addresses or the IP address and subnet mask. 

5. Click Search.

All available servers appear in the Available Servers list.

6. Select the E-820 server you want to use and click Add.
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The selected E-820 server appears in the Login Server dialog box.

7. Click the server name.

The Log In dialog box appears.

8. Select Administrator, Operator, or Guest and click Log In.

Your computer is connected to the server.

To modify the connection to the E-820, you must remove the server from the Login 

Server list and follow the procedure for configuring the connection.
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Configuring the connection for Fiery VDP Resource Manager

The Fiery VDP Resource Manager allows you to view and delete all global objects used 

in variable data printing. For more information, see the Printing Guide.

TO CONFIGURE THE CONNECTION FOR FIERY VDP RESOURCE MANAGER

1. Click Start, choose Programs, and then click Fiery VDP Resource Manager in the 

Fiery folder.

The Available Servers dialog box appears with all E-820 servers in the local 

subnet displayed.
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2. To locate a server by its IP address, click the Manual tab. Enter the IP address and 

click Add.

The server appears in the Available Servers dialog box.

3. To locate the E-820 either by a range of IP addresses or by the IP address and subnet 

mask, click the Auto Search tab and then click Advanced.

4. Click the IP Range tab or the Subnet tab.

5. To search by a range of IP addresses, enter the information in the From IP and 

To IP fields. Click Add and then click Search.

To search by IP address and subnet mask, enter the information in the From IP and 

Subnet fields. Click Add and then click Search.

All available servers will be displayed in the Available Servers dialog box.
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6. Select the servers you want and click Add.

All connected servers are displayed in the Fiery Servers list in the Fiery VDP Resource 

Manager dialog box.

To use the Fiery VDP Resource Manager, see the Printing Guide.

TO MODIFY THE CONFIGURATION FOR FIERY VDP RESOURCE MANAGER

1. Click Start, choose Programs, and then click Fiery VDP Resource Manager in the Fiery 

folder.

All servers you connected to previously are displayed.

2. To remove a server, choose Disconnect from the Server menu.

3. To add a server, choose Connect from the Server menu and follow the procedure for 

configuring the connection on page 1-54.

Configuring a connection for Fiery Link

Use Fiery Link to monitor the status of E-820 servers and view information about the 

print jobs sent to them. 

To view available E-820 servers, open Fiery Link and click the Edit Fiery List button. 

All E-820 servers on the local subnet appear in the Available Fierys list of the Edit My 

Fiery List dialog box. You can specify the E-820 servers to monitor from this dialog 

box. If the E-820 is not in your local subnet, you can configure a connection to the 

E-820 in several different ways, depending on the information you have about the 

E-820, such as a subnet, DNS name, or a range of IP addresses. Print a Configuration 

page to determine this information.

For information on using Fiery Link, see the Printing Guide.

NOTE: Fiery Link is supported over TCP/IP only.
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TO CONFIGURE THE CONNECTION TO E-820 SERVERS IN A LOCAL SUBNET

1. Print a Configuration page.

The information on this page helps you locate the E-820 if it is not on the same local 

subnet as your computer.

2. Start Fiery Link. Click OK in the Warning box if no Fierys are configured, or click the 

Edit My Fiery List button ( ).

The Edit My Fiery List dialog box opens, and all servers found in the local subnet are 

displayed in the Available Fierys area of the dialog box. 

NOTE: Only servers that support Fiery Link appear in the Available Fierys area.

E-820 name, device name (r7), 
and IP address
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3. To add a server to the My Fiery List, select it and click the arrow button. 

The E-820 appears in the My Fiery List. Repeat step 3 for each server you want to 

add to the My Fiery List.

4. Click Apply to accept the changes to My Fiery List. 

5. Click OK.
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If no E-820 servers were found, click Advanced to search a different subnet and 

IP address, or a range of IP addresses. Click the Manual tab to search by DNS name 

or IP address.

If the E-820 was not found and you want to search again using the same parameters, 

click Refresh.
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Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 

Many of the files are PostScript files that you can download and print using 

Fiery Downloader.

Icm folder ICM monitor settings file and a device profile specially designed 

for use with the E-820 and particular copier models. For 

instructions on installing, see “Installing the ICM profiles on a 

Windows computer” on page 1-61.

Clrfiles folder 

(inside the 

English folder)

Cmyk.ps, an 11-page, letter-size PostScript file to use for 

reference when defining CMYK colors in applications.

Pantone.ps, a 19-page, letter-size PostScript file that indicates the 

closest equivalent of PANTONE coated colors that the E-820 

and your copier model can produce. The method used to print 

the Pantone.ps file differs depending on the Spot Color 

Matching setting. For more information, see the Printing Guide 

and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 97 or 

later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to 

view available RGB colors.

Calibrat folder

(inside the 

English\Clrfiles 

folder)

Four PostScript files of color patches for obtaining 

measurements: Custom21.ps, Custom34.ps, Stand21.ps, and 

Stand34.ps. The numbers in the file names refer to the number 

of patches on the page. The Custom files allow you to download 

measurement patches that incorporate the copier’s current 

calibration set. The Standard files allow you to download 

standard measurement patches that bypass the copier’s current 

calibration set. For information on using these files, see 

the Color Guide.

NOTE: These files are provided for expert users and should not be 

used for day-to-day calibration.
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Installing the ICM profiles on a Windows computer

The ICM profiles included in the Icm folder on the User Software CD are for use 

with ColorWise Pro Tools. You can also use the ICM profiles with applications that 

support ICC standards, such as Photoshop. For most ICC-aware applications, the files 

must be installed in a folder named Color in the System folder. For use with 

ColorWise Pro Tools, you can copy the files to a folder of your choice. 

You can upload additional ICC profiles with the Profile Manager in ColorWise 

ProTools. For more information on uploading and using ICC profiles with ColorWise 

Pro Tools, see the Color Guide.

TO INSTALL THE ICM PROFILES ON A WINDOWS COMPUTER

1. On the User Software CD, open the Icm folder.

2. If you are using Windows 9x/Me, copy the profiles to the Windows\System\Color 

folder on your hard disk.

If you are using Windows NT or Windows 2000, copy the profiles to the 

Winnt\System32\Color folder on your hard disk.

NOTE: If a folder named “Color” does not exist in the Sytem32 folder, create one and 

install the profiles into it.

If you are using Windows XP, right-click the profile you want and click Install Profile.

NOTE: The profiles are installed automatically to the 

Windows\System32\spool\drivers\color folder on your hard disk. 

Loading the monitor settings file

The Efirgb.icm monitor settings file can be used in Photoshop, or other applications 

that support ICM profiles, to define a source color space for printing to the E-820.

These instructions assume you have installed the ICM profiles included on the 

User Software CD. For more information, see the preceding section.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

NOTE: If you use Fiery Remote Scan, install the monitor settings profile.



11-62 Installing User Software on a Windows Computer

TO LOAD THE RGB WORKING SPACE PROFILE FOR PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from the Color 

Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. For Windows 9x/Me, browse to the Windows\System\Color folder, select Efirgb.icm, 

and then click Load.

For Windows NT 4.0 or Windows 2000, browse to the Winnt\System32\Color folder, 

select Efirgb.icm, and then click Load.

For Windows XP, browse to the Windows\System32\spool\driver\color folder, select 

Efirgb.icm, and then click Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup dialog box.

5. Click OK.
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For more information about ICM profiles, see your Photoshop documentation.

Loading the ICM copier device profile

This ICM profile defines the target color space for printing to the copier.

These instructions assume you have installed the ICM profiles included on the 

User Software CD. For more information, see “Installing the ICM profiles on a 

Windows computer” on page 1-61.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

TO LOAD THE ICM COPIER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 

Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the E-820 from the Profile menu.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.
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Loading monitor settings files and ICM device profiles in Photoshop 6.x

Once you have installed the Efirgb.icm monitor settings file and the ICM device 

profile for the E-820, they can be loaded at the same time in Photoshop 6.x.

TO LOAD THE MONITOR SETTINGS FILE AND ICM DEVICE PROFILE 
IN PHOTOSHOP 6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and select Advanced Mode in the Color 

Settings dialog box.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the E-820 from the CMYK menu.

5. Click OK.

For more information, see your application’s documentation. 

Installing the printer description files for Windows

The User Software CD contains printer description files for popular Windows 

applications. Pagemaker 5.0, 6.x, and 7.0 do not support automatic installation of 

printer description files from the Printers or Printers and Faxes Control Panel. To make 

the E-820 available in the Print and Page Setup dialog boxes of this application, copy 

printer description files to the appropriate location.

TO COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder 

that corresponds to the system you are using.

For Windows 9x/Me, select English\Prntdrvr\Ps_drvr\Win_9x_ME.

For Windows NT 4.0, select English\Prntdrvr\Ps_drvr\Win_NT4x.

For Windows 2000, select English\Prntdrvr\Ps_drvr\Win_2000.

For Windows XP, select English\Prntdrvr\Ps_drvr\Win_XP.
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2. Copy the printer description file for your E-820 to the appropriate location.

If you use Copy this file To this location

PageMaker 5.0 or later Efa29u22.ppd
(Letter default page size)
Efa29e22.ppd
(A4 default page size)

For PageMaker 5.0, 
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0, 
\PM6\RSRC\USENGLSH\PPD4
For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4
for PageMaker 7.0,
\PM7\RSRC\USENGLSH\PPD4
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The general steps for installing the E-820 user software and setting up printing on a 

Mac OS computer are as follows:

• Install the PostScript printer driver and printer description file.

• Set up the E-820 in the Chooser.

• Install the Fiery utilities (Fiery Scan, Fiery Remote Scan, ColorWise Pro Tools, 

Fiery Link, Fiery Downloader, Fiery VDP Resource Manager, and Fiery Spooler).

• Configure the connection for Fiery utilities.

• Install the printer and screen fonts.

• Install the ColorSync profiles.

• Install additional color reference and application-specific files.

In addition to using the User Software CD, you can download printer drivers and 

the Fiery Link installer from the E-820 with the Installer WebTool (if the site 

administrator has enabled Internet access to the E-820). For instructions, see page 3-2.

Once you download the printer files, the installation process is identical to installing 

from the User Software CD.

Setting up the E-820 as a PostScript printer
To set up the E-820 as a PostScript printer, you must install the PostScript printer 

driver and the printer description file that corresponds to your copier. The PostScript 

printer driver and printer description files are provided on the User Software CD. 

Printer drivers provide a way to communicate information on print jobs between your 

applications, the E-820, and any other PostScript printer connected to your computer.

When you install printer files from the User Software CD or printer files downloaded 

using the Installer WebTool, use the following procedures.

Chapter 2:
Installing 
User Software 
on a Mac OS 
Computer
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TO INSTALL THE ADOBEPS PRINTER DRIVER AND PRINTER DESCRIPTION FILE

1. Quit all open applications.

After you have completed installation, restart your computer.

2. On the User Software CD, open the English: Printer Driver folder.

If you are installing from files you downloaded using the Installer WebTool, open the 

Printer Driver folder on your hard disk.

3. Double-click the AdobePS Installer icon.

4. Follow the on-screen instructions.

The AdobePS Installer installs the Adobe PostScript printer driver, and the printer 

description file that corresponds to the E-820.

NOTE: If you operate the E-820 in a copy shop, quick print shop, or service bureau, 

provide your customers with copies of the printer driver, printer description file, or 

ICC profiles you use for printing images, as well as any relevant documentation. 

This ensures that jobs they create and print to files are properly formatted for printing 

to the E-820.

Setting up the E-820 in the Chooser

After you install the Adobe PostScript printer driver and printer description file (see 

page 2-1), you must set up the E-820 in the Chooser in order to take full advantage of 

its features. This section describes how to set up the E-820 with the AdobePS printer 

driver.

TO SET UP THE E-820 IN THE CHOOSER

1. Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.
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3. Click the AdobePS icon.

The E-820 appears in the Select a PostScript Printer list in the form of 

<server name>_<print connection>. 

NOTE: Only the print connections (Direct, Hold, and Print) that have been enabled 

in Setup appear in the Chooser. 

4. Select a E-820 connection from the “Select a PostScript Printer” list and click Create.

Select the correct printer description file for your printer.

NOTE: You must set up each print connection separately. Repeat this step for all 

enabled connections.

5. Select the icon that appears next to the newly installed E-820 and click Setup.

6. Click Configure in the dialog box that appears.
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7. In the Installable Options dialog box, select the appropriate settings from the menus 

and click OK.

Sorter—Not Installed, Installed

Large Capacity Tray (LCT)—Not Installed, Installed

GA Features—Not Installed, Installed

8. Close the Chooser.

Installing E-820 software and fonts
The Mac OS installers function essentially the same for each type of software. Before 

you begin each installation, determine where you want to install each item on your 

hard disk. Otherwise, the software is placed by default as follows:

• ColorSync profiles—ColorSync Profiles folder.

If you are using ColorSync 2.5, install the profiles into the ColorSync Profiles folder 

inside the System folder. If you are using an earlier version of ColorSync, install the 

profiles to the ColorSync Profiles folder inside the System:Preferences folder. The 

printer profile can be moved to a folder of your choice.

• Fiery Downloader, Fiery Spooler, Fiery Link, Fiery VDP Resource Manager, and 

ColorWise Pro Tools—“Fiery” folder

• Fiery Remote Scan—Supported TWAIN-compliant application software Plug-Ins 

folder
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• Fiery Scan—Supported TWAIN-compliant application software Plug-Ins folder

The installer also creates a folder named TWAIN in your System folder:Preferences 

folder, and installs a Fiery Scan module and Source Manager file into that folder. 

• Fonts—System folder:Fonts folder

For instructions on installing Fonts, see “Fonts” on page 18.

TO INSTALL MAC OS SOFTWARE

1. Insert the User Software CD in the CD drive and double-click the Installer icon of the 

item you want to install, then follow the instructions in the installer dialog boxes.

2. If prompted, click Quit to close the software installer.

Installing MRJ on your computer

In order to use ColorWise Pro Tools, Fiery Link, or Fiery Spooler, you must have 

Mac OS Runtime for Java (MRJ) installed on your computer.

If you do not have MRJ installed, the ColorWise Pro Tools, Fiery Link, or Fiery 

Spooler installer automatically initiates the MRJ installation process.

NOTE: The respective installer prompts the MRJ installation from the User Software 

CD. MRJ 2.2.4 is provided on the User Software CD.

TO INSTALL MAC OS RUNTIME FOR JAVA

1. Open the MRJ folder on the User Software CD and double-click Installer.

2. Read the Apple Computer Inc. License Agreement and click Agree to install the 

software.

3. Click Install.

Some files are installed.

4. Click Quit.

You are now ready to configure the ColorWise Pro Tools, Fiery Spooler, and Fiery Link 

connections to the E-820.



22-6 Installing User Software on a Mac OS Computer

It is recommended that you use the version of MRJ provided on the User Software CD 

with the E-820 software.

If you have a newer version of MRJ (such as 2.2.5) already installed on your computer 

and experience some difficulty using the E-820 software, either remove or relocate the 

MRJ files currently installed and reinstall MRJ provided on the User Software CD. 

Use the following procedure.

TO UNINSTALL MAC OS RUNTIME FOR JAVA

1. Locate the System Folder on your hard disk.

2. Inside the Extensions folder, locate MRJ Libraries and remove or move it to some other 

folder.

NOTE: If you find the “MRJ Enabler” file under Extensions, also remove or move it to 

some other folder.

3. Inside the Apple Extras folder, locate Mac OS Runtime for Java, and remove or move it 

to some other folder.

4. Restart your computer.

Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to configure a 

connection to the E-820.

NOTE: ColorWise Pro Tools are supported only over TCP/IP networks. 

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the IP address of 

the E-820.
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TO CONFIGURE A CONNECTION FOR COLORWISE PRO TOOLS

1. Start the utility by double-clicking its icon.

The Choose Printer Device dialog box appears.

2. If you have previously configured a connection to the E-820, you are ready to use 

ColorWise Pro Tools. If you have not configured a connection, click Add.
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3. Enter the appropriate information for the E-820.

Nickname—Enter a name for the E-820. It does not have to match the actual server 

name of the E-820.

NOTE: The nickname cannot contain any of the following seven characters:

[ ] _ " ' <space> <tab>

Protocol—TCP/IP is the only supported network protocol, so no selection is necessary.

Server Name—Enter the IP address (or DNS or hosts name) of the E-820.

NOTE: You can not enter the DNS name when configuring the connection to the 

E-820 for Fiery utilities on Mac OS.

New Device—Enter the name of the device the E-820 is connected to: r7. This device 

name appears in the Printer Setup section of the Configuration page.

NOTE: The device name is case sensitive; enter it exactly as it appears here.

4. When you have added all the information, click Add.

5. With the device name selected in the Devices list, click OK.

The E-820 appears in the list of available servers. The first line of the entry displays the 

nickname you gave the server, followed by the protocol. The second line displays the 

device name.

6. With the device name selected in the list of Available Servers, click Select to begin 

using ColorWise Pro Tools.

Device name of the E-820
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Modifying the configuration

Edit the configuration whenever there is any change in your original configuration, 

such as a change of IP address. Change the specific E-820 Setup information before 

using the following procedure to configure the connection. 

TO MODIFY THE CONFIGURATION

1. To edit information for a E-820 in the list of available servers, select the E-820 by its 

nickname and click Modify. Edit information in the Modify Server Settings dialog box 

as necessary, and click OK.

2. To add a new E-820 to the list of available servers, click Add. Configure the Add New 

Server dialog box as outlined in steps 3 through 5 in the preceding procedure.

3. To remove a E-820 from the list of available servers, select the E-820 by its nickname 

and click Remove.

Configuring a connection for Fiery Spooler

Before you begin, print a Configuration page from the Control Panel and note the 

IP address of the E-820.

TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER

1. Start the utility by double-clicking its icon.

The Chooser dialog box appears.

2. Click Option.

3. Click Add.
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4. Enter the appropriate information for the E-820.

Name—Enter the IP address (or DNS name) of the E-820.

NOTE: You can not enter the DNS name when configuring the connection to the 

E-820 for Fiery utilities on Mac OS.

New Device—Enter the name of the device that the E-820 is connected to: r7. 

This device name appears in the Printer Setup section of the Configuration page.

5. When you have entered all the information, click Add.

6. With the device name selected, click OK.

The E-820 appears in a list of configured servers.

7. Click OK in the Configure dialog box.

The E-820 appears in a list of available servers.

8. With the E-820 selected in the list of available servers, click OK to begin using 

Fiery Spooler.

E-820 name and device name (r7)

E-820 name and device name (r7)
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Modifying the configuration

Edit the configuration whenever there is any change to your E-820 or network, such as 

an IP address or device change. Change the specific E-820 Setup information before 

configuring the connection.

TO MODIFY THE CONFIGURATION

1. In the Chooser dialog box, click Option.

2. To edit information for a E-820, select the E-820 by its IP address or DNS name and 

click Modify. Edit information in the Settings dialog box as necessary, and click OK. 

3. To add a new E-820, click Add. Configure the Settings dialog box as outlined in steps 4 

through 6 in the preceding procedure.

4. To remove a E-820, select the E-820 by its IP address or DNS name, and click Remove. 

The list of available servers reflects the modifications you have made.

Configuring a connection for Fiery Link

Use Fiery Link to monitor the status of E-820 servers and view information about the 

print jobs sent to them. 

To view available E-820 servers, open Fiery Link and click the Edit Fiery List button. 

All E-820 servers on the local subnet appear in the Available Fierys list of the Edit My 

Fiery List dialog box. You can specify the E-820 servers to monitor from this dialog 

box. If the E-820 is not in your local subnet, you can configure a connection to the 

E-820 in several different ways, depending on the information you have about the 

E-820, such as a subnet, DNS name, or a range of IP addresses. Print a Configuration 

page to determine this information.

For information on using Fiery Link, see the Printing Guide.

NOTE: Fiery Link is supported over TCP/IP only.
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TO CONFIGURE THE CONNECTION TO E-820 SERVERS IN A LOCAL SUBNET

1. Print a Configuration page.

The information on this page helps you locate the E-820 if it is not on the same local 

subnet as your computer.

2. Start Fiery Link, and click the Edit My Fiery List button .

The Edit My Fiery List dialog box opens, and all servers found in the local subnet are 

displayed in the Available Fierys area of the dialog box. 

NOTE: Only servers that support Fiery Link appear in the Available Fierys area.

E-820 name, device name (r7), 
and IP address
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3. To add a server to the My Fiery List, select it and click the arrow button. 

The E-820 appears in the My Fiery List. Repeat step 3 for each server you want to add 

to the My Fiery List.

4. Click Apply to accept the changes to My Fiery List. 

5. Click OK.

If no E-820 servers were found, click Advanced to search a different subnet and 

IP address, or a range of IP addresses. Click the Manual tab to search by DNS name 

or IP address.

NOTE: On Mac OS, you cannot enter the DNS name when configuring the connection 

to the E-820 for Fiery utilities.

E-820 name, device name (r7), 
and IP address
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If the E-820 was not found, and you want to search again using the same parameters, 

click Refresh.

Configuring a connection for Fiery Downloader

When you start Fiery Downloader, you must specify the connection to the E-820.

BEFORE YOU BEGIN

• Print the Configuration page from the Control Panel and note the AppleTalk zone of 

the E-820.

TO SPECIFY A E-820 CONNECTION

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the E-820 is located from the AppleTalk Zones list.

The available servers appear in the Servers list.

E-820 name
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3. Select the E-820 in the Servers list.

4. Click Connect.

The Fiery Downloader dialog box appears.

For information on how to use Fiery Downloader, see the Printing Guide.

E-820 name and device name (r7)
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Configuring the connection for Fiery VDP Resource Manager

The Fiery VDP Resource Manager allows you to view and delete all global objects used 

in variable data printing. For more information, see the Printing Guide.

TO CONFIGURE THE CONNECTION FOR FIERY VDP RESOURCE MANAGER

1. Click Fiery VDP Resource Manager in the Fiery folder.

All servers you connected to previously are displayed. If no servers are displayed, you 

can locate and add them.
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2. Choose Connect from the Server menu.

The Available Servers dialog box appears with all E-820 servers located in the 

subnet displayed.

3. Click the Manual tab to locate a E-820 server by its IP address. Enter the IP address 

and click Add.

E-820 name and device 
name (r7)
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4. Click the Auto Search tab and then click Advanced to search by either a range of 

IP addresses or the IP address and subnet mask. 

5. Click Add and then click Search.

All VDP servers located appear in the Available Servers dialog box.

6. Select the servers you want and click Add.

The selected servers appear in the list of VDP servers in the Fiery Variable Data 

Resource Manager dialog box.

Fonts

The Fonts installer on the User Software CD includes screen and printer fonts that 

correspond to the 136 built-in PostScript printer fonts on the E-820. The Font 

installer copies both kinds of fonts to the System:Fonts folder on your hard disk. 

To be available to applications, the screen fonts must remain in the System:Fonts 

folder. You can copy the printer fonts to a folder of your choice. 

NOTE: In the System:Fonts folder, when displayed by Kind, screen fonts appear as type 

“Font Suitcase” and PostScript printer fonts appear as type “PostScript font.”

TO INSTALL SCREEN AND PRINTER FONTS

1. On the User Software CD, double-click the Fonts icon to start the Fonts installer. 

2. Click Install and restart your computer.

By default, the fonts are installed to the System folder:Fonts folder on your hard disk.
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If you have any applications open, you must quit and restart them before the newly 

installed screen fonts are available.

Installing color files from the User Software CD
You can copy additional color files from the User Software CD to your hard disk. 

Many of the files are PostScript files you can download and print using 

Fiery Downloader.

The User Software CD contains the following color files:

ICC profiles 

(inside the 

ColorSync folder)

If you are using ColorSync 2.5, install the ICC profiles into 

the ColorSync Profiles folder inside the System folder. If you 

are using an earlier version of ColorSync, install the ICC 

profiles to the ColorSync Profiles folder inside the 

System:Preferences folder. The printer profile can be moved 

to a folder of your choice.

Color Files folder 

(inside the English 

folder)

CMYK Color Reference.ps, an 11-page, letter-size PostScript 

file to use for reference when defining CMYK colors in 

applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file 

that indicates the closest equivalent of PANTONE coated 

colors that the E-820 and your particular copier model can 

produce. The method used to print the PANTONE Book.ps 

file differs depending on the Spot Color Matching setting. 

For more information, see the Printing Guide and the Color 

Guide.

RGB page 01, a file you can print from Microsoft Word 97 

or later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 or 

later to view available RGB colors.
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Loading ICC profiles

The ICC profiles installed are for use with ColorWise Pro Tools and applications that 

support ICC standards. 

These instructions assume that you have already installed the ICC profiles included on 

the User Software CD inside the ColorSync folder. For more information, see 

“Installing color files from the User Software CD” on page 19.

NOTE: The internal name of an ICC profile may vary slightly from its file name.

The following procedure describes installing the ICC profiles with ColorSync 4.0. 

For more information about ColorSync, see your application’s documentation.

Calibration folder

(inside Color Files 

folder)

Four measurements files of color patches: custom21.ps, 

custom34.ps, standard21.ps and standard34.ps. The 

numbers in the file names refer to the number of patches on 

the page. The Custom files are provided to allow you to 

download measurement patches that incorporate the copier’s 

current calibration set. The Standard files are provided to 

allow you to download standard measurement patches that 

bypass the copier’s current calibration set. For information 

on using these files, see the Color Guide.

These files are provided for expert users and should not be 

used for day-to-day calibration.



22-21 Installing color files from the User Software CD

TO SET THE COLORSYNC SYSTEM PROFILE

1. Choose Control Panels:ColorSync from the Apple Menu.

2. Select EFIRGB ICC v1f from the System Profile list.

When selected as the ColorSync system profile, EFIRGB ICC v1f sets the optimal 

source color space for printing to the E-820. The color space set by the EFIRGB ICC 

v1f profile is the same as that set by the EFIRGB setting of the RGB Source Profile 

print option. 

NOTE: The RGB Source Profile print option setting overrides the ColorSync system 

profile setting. 

3. Close the ColorSync dialog box.

For more information about ICC profiles, see your Photoshop documentation.
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Loading the monitor settings file

The EFIRGB ICC monitor settings file can be used in Photoshop or other applications 

that support ICC profiles to define a source color space for printing to the E-820.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from the Color 

Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System: Preferences: ColorSync Profiles folder, select the EFIRGB ICC 

file, and then click Open.

NOTE: If you are using ColorSync 2.5, the ColorSync profile is located in System 

Folder:ColorSync Profiles.

The EFIRGB v1f file appears as the selection.

5. Click OK.
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Loading the ICC copier profile

The ICC copier profile enables RGB-to-CMYK conversions that are specific to the 

kind of copier you are using. 

TO LOAD THE ICC COPIER PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color 

Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the E-820 from the Profile menu.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.

Loading the monitor settings file and the ICC device profile in Photoshop 6.x

In Photoshop 6.x, you can load the monitor settings file and the ICC device profile at 

the same time.

TO LOAD THE MONITOR SETTINGS FILE AND THE ICC DEVICE 
PROFILE IN PHOTOSHOP 6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.

3. Choose EFI RGB from the RGB menu.

4. Select the profile that corresponds to the E-820 from the CMYK menu.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your E-820 remotely from the Internet or from 

your company’s intranet. The E-820 has its own home page, from which you can select 

a variety of functions, including Status, WebSpooler, WebLink, Installer, 

WebDownloader, WebSetup, and WebScan.

For more information on using Fiery WebTools, see the Printing Guide.

Setting up Fiery WebTools

In order for network users to access and use Fiery WebTools, you must set specific 

E-820 options in Network Setup and Printer Setup. You also must prepare each user’s 

computer to communicate with the E-820 over the Internet or intranet.

For more information about Network Setup and Printer Setup, see the 

Configuration Guide.

TO SET UP CLIENT WORKSTATIONS TO USE FIERY WEBTOOLS

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure a supported Internet browser is installed on the computer.

For more information on supported browsers, see the Quick Start Guide.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the E-820 and the network, see the 

Configuration Guide.

Chapter 3:
Downloading 
Installers with 
Fiery WebTools
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Using the Fiery WebTools Installer

The Installer WebTool allows you to download installers for printer drivers and Fiery 

Link directly from the E-820 to your computer.

TO DOWNLOAD PRINTER DRIVER OR FIERY LINK FILES WITH 
THE INSTALLER WEBTOOL

1. Start your Internet or intranet browser and enter the DNS name or IP address of 

the E-820.

2. Select a login level, enter a password if required, and then click OK.

No password is required to log in as Guest. If the Administrator has configured Guest 

access, any user has full access to the Installer WebTool while logged in as Guest.

3. Click Installer.

4. Under the name of your operating system, click the name of the item you want 

to install.
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5. For installation of printer drivers, continue with the following instructions.

A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the 

program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Drive or Fiery Link is downloaded to 

the desktop in a BinHex-encoded, compressed format. If your Internet browser is 

equipped with an expander utility, such as StuffIt Expander, the folder will decode and 

decompress automatically.

6. For Windows computers, browse to the location where you want to save the 

Prntdrve.exe or the Fiery Link.exe file and click Save.

For Mac OS computers, if the Printer Driver or Fiery Link folder was not 

automatically decoded and decompressed, start the utility that will perform that 

function.

7. For Windows computers, double-click the Prntdrve.exe or the Fiery Link.exe file, 

browse to the location where you want to install the folder, and then click Next.

The folder is installed to the location you specified.

8. Install the appropriate printer driver for your operating system.

For instructions on installing 
the printer driver for

See

Windows 9x/Me “To install the PostScript printer driver for 
Windows 9x/Me” on page 1-2

Windows NT 4.0 “To install the PostScript printer driver for 
Windows NT 4.0” on page 1-13

Windows 2000/XP “To install the PostScript printer driver for 
Windows 2000/XP” on page 1-27

Mac OS “To install the AdobePS printer driver and printer 
description file” on page 2-2
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows NT 4.0 or Windows 2000/XP 
computers

If you have problems installing the E-820 with Windows NT 4.0 or 

Windows 2000/XP, try installing another PostScript printer (such as the Apple 

LaserWriter IIg), and then install the E-820. Installing another printer ensures that all 

files are properly installed and available. For instructions, see your Windows 

documentation.

For additional information about problems you may encounter using the PostScript 

Printer Driver for Windows NT 4.0, see the Adobe README file (readme.wri) 

included in English\Prntdrvr\Ps_drvr\Win_NT4x on the User Software CD. 

For Windows 2000/XP, see your Windows 2000/XP documentation.

Reinstalling the Adobe PostScript Printer Driver on 
Windows 9x/Me

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 

and related files before installation.

For additional information about problems you may encounter using the Adobe 

Printer Driver for Windows 9x/Me, see the Adobe README file (readme.wri) 

included in English\Prntdrvr\Ps_drvr\Win_9x on the User Software CD.

Chapter 4:
Troubleshooting
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Problems with the Fiery utilities on Windows computers

If you are experiencing problems with connections for the Fiery utilities, try the 

following:

1. Make sure the TCP/IP networking protocol is enabled. 

2. Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose Open from the File 

menu. Select the E-820 and click Modify to see current settings. If the settings are 

incorrect, you can change them in this dialog box.

On a Mac OS computer

Setting up the E-820 in the Chooser

If Auto-setup does not work and you are prompted to select the printer description file, 

select the appropriate E-820 file in your System:Extensions:Printer Descriptions 

folder, “E-820 R7 Color Server US” or “E-820 R7 Color Server”.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User 

Software CD to the System folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System folder.

3. Move fonts you are not using from the System folder:Fonts folder to the 

Uninstalled Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts 

to the System folder:Fonts folder.

5. Create aliases to the System folder:Fonts folder and the Uninstalled Fonts folder.
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6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and restart them in order to view 

and use the newly installed fonts.

Alternatively, you can try combining fonts from multiple suitcases into a single 

suitcase.
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setting up 3-1

Status xvi
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WebLink xvi
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Multiple Master xii
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TrueType xii, xiii

Fonts folder 4-2

Frame Type option 1-7

I
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printing for Windows 2000/XP 1-37 to 

1-38

printing for Windows NT 4.0 1-23

Windows 2000/XP 1-37

Windows NT 4.0 1-21

IPX/SPX
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troubleshooting 4-2

monitor settings file, Mac OS 2-22

N

NetWare client setup

Windows 9x/Me 1-21, 1-37
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loading the ICM device profile 
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Photoshop 6.x
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Windows 9x/Me 1-3

Windows 2000/XP 1-28

Windows NT 4.0 1-14
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Windows 2000/XP 1-30

Windows 9x/Me 1-4
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printing

Windows 2000/XP 1-34
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see also PostScript printing
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Spooler, see Fiery Spooler
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Stand21.ps (Windows) 1-60
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Stand34.ps (Windows) 1-60
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T
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Token Ring, option xii

troubleshooting

Mac OS computers 4-2

Windows computers 4-1
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User Software CD

contents (Mac OS) 2-1

contents (Windows) 1-46

installing from, for Mac OS 2-2, 2-19

troubleshooting fonts 4-2

W

WebDownloader WebTool, see Fiery 

WebTools

WebScan xvi

WebSetup WebTool, see Fiery WebTools

Windows

copying color files 1-60

installing Fiery utilities 1-46

troubleshooting 4-1
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